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This user guide provides basic instructions for setting up SEADA G44 HDM I video wall controllers using
its management software.
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1. Product Introduction

1.1. Product profile

The G44 HDMI version of video wall controller accepts up to 4 HDMI inputs and displays them on 4
different displays, each with a resolution up to 4K@60fps 4:4:4. G44 HDMI not only allows the user to
display a single input across all four screens, but also to display different input videos onto different
screens working like a matrix switcher. Moreover, it also supports audio matrix, IR matrix and CEC
management.

1.2. Product capability

Four HDMI 2.0 inputs with embedded audio

Four HDMI 2.0 outputs with embedded audio

Each input and output support resolutions up to 4K@60Hz 4:4:4
Four analog audio inputs

Four analog audio outputs

Four digital audio outputs

Independent 4x4 IR Matrix

Support audio embedded and de-embedded

Support video wall function

Support presentation switching function

Support seamless matrix switching function

Support CEC management

Support EDID management

Custom pre-set layouts for both Matrix and Video Wall Modes
HDCP compliant

Adjust Display settings such as Contrast and Saturation remotely
Controllable via IP/serial port

Controllable via front panel buttons

www.seada.co.uk
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1.3. Specification & Parameters

Interface HDMI-A

HDMI Version HDMI2.0, HDCP2.2

Bandwidth 18Gbps
800x600@60Hz,1024x768 @60Hz, 1280x768 @60Hz,
1280x800@60Hz,1280x1024@60Hz,1360x768@60Hz,
1366x768@60Hz,1400x1050@60Hz,1440x900@60Hz,
1600x1200@60Hz,1680x1050@60Hz,

Input 1920x1200@60Hz,480p,576p,720p,1920x1080i,
1920x1080p,3840x2160@24Hz/25Hz/30Hz/50Hz/60Hz,
4096x2160@24Hz/25Hz/30Hz/50Hz/60Hz.

Output 3840x2160@60Hz, 3840x2160@50Hz,

3840x2160@30Hz, 3840x2160@25Hz,
1920x1200@60Hz,1920x1080@60Hz,
1920x1080@50Hz,1600x1200@60Hz,
1400x1050@60Hz,1366x768@60Hz,
1360x768@60Hz, 1280x1024@60Hz,
1280x768@60Hz, 1280x720@60Hz,
1280x720@50Hz, 1024x768@60Hz

HDMI Amplitude

T.M.D.S +/- 0.4Vpp

Differential impedance

100+150hm

RS232/Ethernet control

Baud rate and protocol

Baud rate: 9600, data bit: 8,

stop bit: 1, no parity checking

Ethernet

IE10.0+, HTML5

Power

Max Consumption

60W, 110-240VAC

Matrix Mechanical dimensions

Size(mm) 480(L)X245(W)X44.55 (H) including brackets
Weight 3.2Kg

Operating temperature 0 to 40°C

Storage temperature -20to 70°C

Permissible humidity

10%-50%

www.seada.co.uk
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2. Hardware Overview
2.1.Front Panel

ouTPUT U
3 EDID NEXT

-
1 [ oo

INPUT SAVE RECALL CLEAR TAKE

CoM

SEADA

G44 VIDEO WALL CONTROLLER

IR LOCK

(-0
OO0
-0
|

e OUTPUT/INPUT Buttons

Press buttons OUTPUT n + INPUT m+ ENTER by sequence, switch input n to output m

e Lock Button

Press button more than 2 seconds and less than 6 seconds, to lock or un-lock front buttons. When locked, the Lock LED will be on.

Press button LOCK more than 6 seconds enter into the input output lock menu, then press INPUT Or OUTPUT button to toggle the input or output lock
status, then press ENTER to confirm, Press CLEAR to exit.

e MENU Buttons

Press buttons ALL + INPUT m + ENTER by sequence, to switch input m to all the outputs

Press buttons SAVE + OUTPUT n to save current matrix/video wall layout as layout n. it can save up to 8 layouts

Press buttons RECALL + OUTPUT n to recall layout n

Press buttons RES + OUTPUT n + NEXT + ENTER, to change output resolution on OUTPUT n

Resolution choices: 3840x2160@60, 3840x2160@50, 3840x2160@30, 3840x2160@25, 1920x1200@60,1920x1080@60, 1920x1080@50,
1600x1200@60, 1400x1050@60, 1366x768@60,1360x768 @60,1280x1024@60, 1280x768@60,1280x720@60, 1280x720@50, 1024x768 @60
Press buttons EDID + INPUT m + NEXT + ENTER, change the EDID mode of port INPUT m

EDID option: Manual, 3840x2160@60, 3840x2160@30, 1920x1200@60,1920x1080@60, 1280x1024 @60, 1280x720@60, 1024x768@60
Manual EDID is loaded using G44H software

Note: all these functions are also available using G44H software.

www.seada.co.uk
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2.2. Rear Panel

AJ3 0 OuT :’U

(/—( RS232 IROUTPUT IR INPUT :‘ LO ‘NFEV; ¥ = C k- M \ CE -
| EE|ooo o’:, 00 m‘ LBE}Z]][[ E]EJB]F lumﬂl-éb [F[[ I-o [G65 [El-@ [‘-EETTI-Q' j W = o
LAN wH R | 1 2 3 “ 1 2 ‘ Fc | (== ‘,//'l
‘@‘ ! - INPUT : ! ! a) : OUTPUT . ) "—‘ 110-240VAC S0/60H2z 'L:

e LAN(10M/100M/1000M) and RS232 Ports
e [RINandIROUT
IR IN/OUT routing follows video matrix routing
e Audio Input
4 x 3-way Phoenix connectors to input external analog LR audio, user can select this audio to replace the corresponding embedded HDMI audio
e Audio Output
4 x 5-way Phoenix connectors to output balanced LR audio, and 4 mini Toslink jackets to output analog LR audio and digital Spdif audio.
The 4 Audio output (LR and Toslink) channels can be independent from video and switched by G44H software or 3™ party controller using command lines
e HDMI Inputs
4 x HDMI 2.0 inputs with embeded audio
e  HDMI Outputs
4 x HDMI 2.0 outputs with embeded audio
e Power Supply Socket
110 ~ 240 VAC

www.seada.co.uk
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3. Connection Setup

3.1.RS232 wiring

RS-232 control, baud rate 9600, 3-Pin Phoenix connector

E| E| IE| TX Pin, G44 HDMI--->PC
TX

< RX RX Pin, G44 HDMI<---PC

3.2.RS232 and Ethernet Connection

Connect the G44 HDMI unit with the control PC using either CAT cable or wired serial cable.

4. G44H Software User Guide

Users can run the G44H.exe software directly without installation. Software is on the disk in the
package or you can download it from the SEADA website. Double click the G44H software to get the
Ul as below:

Matrix Switch lAdvanced Switchl Signal Seﬂing] PQ&Position I Video Wall I CEC Control 1 Network Seﬂing] English ~

Inputl Inp Input3 | Inputd Inputl Input2 | |Input3 | Inputd
-5 -3 -4 [ ] [ ] [ ]
(o] (o] (o]

Audio-Outputl

Video-Output3

Video-Output4

Audio Only Unavailable Switch Made (@) Follow Video () Manual
Allset | Inputl ~ Recall Model  ~ SaveAs Model  ~
Ctrl Mode
(O UART @ Network  Port ~ Status | Connected | | Reset | ading: Output Board3 -=Signal Resolution Succeeded | #
ading: Output Board4 -=Signal Type Succeeded
Device Name IP Address MAC Address Version ad!ng: Sajprii e 7>S!gna| Type SL‘!“EEdEd
ading: Output Board4 -=Signal Resolution Succeeded
K3 192.168.0.247 ABA4CSEE3ED 78 3015 ading: Output Board4 -=Signal Resolution Succeeded
ading: Screen Combine Succeeded
ading: All Information Succeeded!
v

- MNote: Please wait until all data reading completed!
@ comp

There are 7 main tabs in this software to help users set up and control the G44 HDMI video wall
controller.
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4.1. Matrix Switch

Users can connect the G44 HDMI device to control PC and set up the device as matrix switcher in this
section.

4.1.1. Connect to the G44 HDMI via UART for RS232

Connect the G44 HDMI to the control PC with a serial cable (a RS232 to USB cable is included in the

package)
Ctrl Mode If the software was connected via UART
@UART ONetwork  Port = i (RS232) last time, software will connect

to the G44 HDMI automatically via
RS232. If it was used at Network last time, a ‘Network Timeout’ error message will be shown on
screen and users need to set up as below for R$232 connection in the software

. * Choose ‘UART instead of ‘Network’
o ¢ Select the COM port from the Port dropdown menu
. * Press ‘Disconnected’ button to connect

The software will check all the parts of the device. A ‘Read data succeeded’ dialog box will be shown
on screen when finished.

4.1.2. Connect to the G44 HDMI via Network

The default IP address for G44 HDMI controller is 192.168.0.247, Users need to change the IP
address of the control PC to the same network segment as the G44 HDMI.

¢ Change the ‘Obtain an IP address automatically’ to ‘Use the following IP address’ to set up a
static IP address of TCP/IPv4 in Ethernet Properties

>|P address: any address between 192.168.0.2 and 192.168.0.254 except the address which has
been taken by the G44 HDMI

>Subnet mask: 255.255.255.0, Default Gateway: 192.168.0.1

Ctrl Mode

OUART @Network  Port S

Device Name IP Address MAC Address Version
K3 192.168.0.247 A6 4CSEE4 3EF9 3015

Connect the G44 HDMI with a CAT cable to the control

PC (cable included in the package)

If the software was connected via Network last time, software will connect to the G44 HDMI
automatically via network. If it was used at serial port last time, a ‘Please select COM port’ error
message will be shown on screen and users need to set up as below for Network connection in the
software

¢ Choose ‘Network’ instead of ‘UART’

¢ Press ‘Search Device’ button to find the G44 HDMI on the network

¢ Highlight the device Press ‘Disconnected’ button to connect

www.seada.co.uk



“SEADA G44 HDMI User Guide

Showing the World

4.1.3. Matrix Switch Routing
Users can switch and assign different inputs to the Inputl | |lnput2 ||Input3 ||Inputd
selected outputs in the matrix. The name of the 91 L .3 94
input/output can also be changed by selecting the Video-Output1
default name — Input1/Video-Outputl and Video-Output?2
replacing it with the chosen name. Video-Output3

Video-Output4

Users need to disable the video wall mode (Cancel the splicing) to enable the matrix switcher mode

4.1.4. Allset, Recall, Save As and Reset

Allset  Inputl v Recall Model v SaveAs Model v

Ctrl Mode
@UART ONetwork  Port v Status bisconneded’ l Reset I ’ ’

e The Allset dropdown menu helps the users select a single input to be displayed on all of the
screens (i.e. Allset Input 4 would display Input 4 on Output 1, Qutput 2, Output 3 and Output 4)

e Recall Mode: Recall a preset layout. The device supports maximum 8 scenes.

e SaveAs Mode: Save up to 8 preset layouts

e Reset: Reset the unit to default factory configuration.

e EDID:
&:oo a x|V Read: read the EDID of the selected output
i s v' Save: save the displayed EDID after ‘Read’
_ v Open: open an EDID from previous saved EDID
or 2 0 o v’ Write: write the current displayed EDID onto selected input
to customized input EDID

90 01 02 03 64 @5 06 97 08 09 @A @B OC @D OF oF

www.seada.co.uk
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4.1.5. Audio Matrix

: . Follow Video Mode — The
nputl Input2 Input3 Input4

® @ Y LR and Toslink audio outputs will

* e L follow the video output embedded
Audio-Output1 audio. Meaning that analog audio
Audio-Output2 output 1 will have the same audio as
Audio-Output3 3 HDMI output 1, analog audio output

2 will have the same audio as HDMI
output 2 etc.
Audio Only Unavailable Switch Mode O Follow Video (O Manual e Manual Mode - This allows

Audio-Output4

the user to control the audio source
separately from the HDMI output ports. The analog audio output can be from any analog
audio input port or any embedded audio of HDMI input.
e L/R

HDMI output embedded audio will get the audio from the corresponding analog audio of the
HDMI input to be displayed on the output channel

e Auto

HDMI output embedded audio will get the audio from the embedded audio of the HDMI input to
be displayed on the output channel. If the input source is DVI, the output system will get the
audio from the input analog audio

www.seada.co.uk
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4.2. Advanced Switch

Matrix Switch Advanced Switch l Signal Setting I PQ&Position ] 0osD Setupl Video Wall I CEC Control l Network Setting |

Usage note: 1. Add input to output 2. Tick output and then start sending loop

Input Custom name Output Custom name  Input Signal @® Send cmd periodically {2000 J ms
Input 1 [J Output 1 Video-Output1 [JSend All Outputs Combined
Input 2 [JOutput 2  Video-Output2 .

) When others finished, start a next loop
Input 3 [JOutput 3  Video-Output3
Input 4 [J Output 4  Video-Outputd [JStop CMD after one loop

[JSelect all outputs

Start Stop

The Advanced Switch tab will repeatedly send a batch of matrix selection commands at the interval
time specified in ‘Send cmd Periodically’
1. Select one or more outputs.
2. Select one input.
3. Use the arrow button (-->) to assign that input to the selected output or outputs.
4. When all required selections have been set up, click the Start button to run the commands.
The available options are:
e All outputs send combined — Include all outputs that have the content from the same input
as a single command.
e When others finished, start a next loop — Wait for all commands in the previous to finish
before sending the next batch of commands.
e Stop cmd after one loop — Only send the commands once, no looping.
o Select all outputs — Selects all outputs when checked. Unselects all outputs when unchecked.
e Start — Begin the command cycles.
e  Stop — Stop the command cycles.

www.seada.co.uk
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4.3. Signal setting

Matrix Switch | Advanced Switch Signal Setting I PQ&Position I OSD Setup I Video Wall I CEC Control | Network Setting |
—Input Board—| Read All Output Bnard—@
Label Input Type Input Format Label Output Type Output Format
3 2 3 Z g

Signal Settings tab, users can use the ‘Read All’ function button to recognize the type and resolution
automatically. Additionally, you can also manually read one Input/output at a time — pressing the
Read button next to the selected input will only read that input alone.

(N Input Type Shows the input video sources type (HDMI or DVI)
1l Input Format Shows the resolution of the input video sources

1. Output Type

¢ UHD-HDMI Set the respective output signal to HDMI without HDCP.

¢ UHD-DVI Set the respective output signal to DVI, with no audio output

e UHD-HDMII 1.4 Set the respective output signal to HDMI with HDCP 1.4 compliance.
¢ UHD-HDMI 2.2 Set the respective output signal to HDMI with HDCP 2.2 compliance.
V. Output Format

Users can manually change the output resolution here to match the requirement of the receiving
side (the default setting is 1920 x 1080@60, there are total 16 preset resolutions to choose from)

www.seada.co.uk
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4.4, PQ & Position

Matrix Switch | Advanced Switch | Signal Setting PO&Position }video Wall| CEC Control | Network Setting |

Select PQ FineTune Port- Qutput1

Brightness W
Contrast ¥

=]
[ree]

Saturation ¥

Innn

Sharpness ¥

Cool

=
i
o

OOC O 8

Read

Reset

Read

Reset

4.4.1. PQ Control

This section allows the user to fine-tune the settings of their screen from the G44H software.

The dropdown menu at the top of the section allows the user to select which screen to apply the
settings to.

The read option reads the settings of the monitor/screen that are already in place and adjusts the
values in the software, while the reset button will reset the settings to their default after they have
been manually adjusted.

www.seada.co.uk
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4.5. Video Wall

Matrix Switch | Advanced Switch | Signal Setting | PQ&Position I OSD Setup Video Wall ICEC Control ] Network Setting |

—  VideoWall Setting —1 Video Wall
Rows 2 '
Columns 2 [ Screen 1 Screen 2
Available 4 9
| Sot I I e | Screen Splicing
Cancel Splicing
— Layout Save/Load — Screen 3
Input Select >
I Save Layout I I Load Layout I
Output Select >
Output Type >
Output Format >
Horizontal adjust
nc lock

4.5.1. Video Wall Layout Setup

. Users can set up the layout of the video wall in ‘VideoWall Setting’ by
Rows 2 ] . . . .
- v simply choosing how many rows and columns the video wall consists of.
olumns
. Total screens amount is up to 4 for G44 HDMI video wall controllers.
Available 4 B
I Set “ Read I

4.5.2. Creating the video wall

Video Wall

Screen 1 Screen 2
Screen Splicing
Cancel Splicing

Screen 3
Input Select >
Output Select >
Output Type >
Output Format >
Horizontal adjust

Vertical adjust

Sync lock

Click to select the screen, then drag & select the screens to splice, right-click, and click Screen
splicing to form a video wall.
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e Screen Splicing - This combines the selected screens into one and displays the selected input
across all the splicing screens. For example, in the setup below 2x2, if all of them are spliced,
then the input selected by the user will be displayed across all the 4 screens (Note: this is not
the same as duplicating a single input on each output).

e Cancel Splicing — This will cancel the video wall and revert to the matrix switching mode.

e Input Select — Similarly to the video routing matrix, this allows the user to control which
output is displayed on which screen (Note: Selecting an input on any of the screens when
spliced will display it on the spliced screen and not on the individual screen).

e Output Select — The user can control which screen should be mapped to which output.

e QOutput Type — Allows the user to adjust the type of the output — HDMI or DVI.

e Output Format — Controls the resolution of the output.

e Horizontal adjust — Lets the user adjust the horizontal position of the screen.

e Vertical adjust — Lets the user adjust the vertical position of the screen.

The user can save the video wall preset layouts and load it later via the Save Layout and Load Layout
dropdown menu.

www.seada.co.uk
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4.6. CEC Control

Matrix Switch | Advanced Switch | Signal Setting i PQ&Position I 0osD Setupl Video Wall CEC Control INetwork Setting |

Auto Power ON

Input Output
input1 | Power ON | [ Power OFF | Output1 | Power ON | | Power OFF | [ Volume+ |[ Volume- | [Mute/Unmute|
input2 | Power ON | [ Power OFF | Output2 | Power ON | | Power OFF | [ Volume+ |[ Volume- | [Mute/unmute]
input3 | Power ON | [ Power OFF | Output3 | Power ON | | Power OFF | | Volume+ |[ Volume- | [Mute/Unmute|
input4 | Power ON | [ Power OFF | Output4 | Power ON | | Power OFF | [ Volume+ |[ Volume- | [Mute/Unmute|

When Auto Power On is enabled, once G44 HDMI is powered up, all the video source devices and
displayers, which support CEC, connecting to G44 HDMI unit will be switched on.

G44 HDMI version CEC function include Power on/off, Volume+/- Mute/Unmute

4.7. Network Setting

Matrix Switchl Advanced Swilchl Signal Seﬂingl PQ&Paosition l Video Wall l CEC Control Network Setting l

% Select config port

Search List (Click device to load configuration) DPort0  CPort1  (OPort2
Device Name IP Address MAC Address Version
K3 192.168.0.247 AGACSEE3ED 78 3015

|Search De'\ricel |C}pen Websitel |Find via UARTl PC Port |:|

Basic config

[ ] Gatewsy [ . . . ] Sync BaudRate(RFC2217 similar)

| ——|
Save Config | Save Coniig |

Users can find all the device network information in this section and do the modification if needed.
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5. Remote Control

e  Output/Input Buttons

Press buttons Input x under the Output (A/B/C/D) section, switch input x to
outputy

. Arrow Buttons
Cycles through the inputs on your selected output (A/B/C/D)

6. Command Lines
6.1. Matrix Video Routing

Operation | Spacer Target Spacer | Command | Command Command tail
type type arameters
vp (1 byte) (N bytes) (1byte) | P P (1 byte)
(3 byte) (10 bytes) (N bytes)
SET Space INX/INxx/INxxx Space VIDEO OUTa [OUTh | ¢
OUTc... .
x is the input port I This is ASCII
number or carriage

return 0x0d
ALL

For example,
IN1/INO1/INOO1

A. Setvideo route: Input port-x/xx/xxx switch to output port-a/b/c..., or all output ports
For example: SET video route: Input port 1 switch to output port 1
Send: SET IN1 VIDEO OUT1+ Receive: IN1 VIDEO OUT1
For example: SET video route: Input port 1 switch to output port 1,2,3
Send: SET IN1 VIDEO OUT1 OUT2 OUT3+ Receive: IN1 VIDEO OUT1 OUT2 OUT3
For example: SET video route: Input port 1 switch to all output ports
Send: SET IN1 VIDEO ALL+ Receive: IN1 VIDEO ALL

www.seada.co.uk
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6.2. Matrix Audio Routing
Operation | Spacer Target Spacer Command type Command Command
type parameters tail
(1 byte) (N bytes) (1 byte) (10 bytes)
(3 byte) (0 or 1/2/3 bytes) (1 byte)
GET/SET Space INX/INXx/INXXX Space AUDIO-ROUTE OUTX/OUTxx/OUTxx \
X .
x is the input This is
port number ASCII
carriage
return
For example, 0x0d
IN1/INO1/INO
01
Send: GET IN1 AUDIO-ROUTE+ Receive: IN1 AUDIO-ROUTE OUT1
Send: SET IN1 AUDIO-ROUTE OUT2 Receive: IN1 AUDIO-ROUTE OUT2
6.3. Recall/Save Layout
Operation Spacer Target Spacer | Command Command Command tail
type type arameters
vp (1byte) | (Nbytes) | (1byte) | " P (1 byte)
(3 byte) (10 bytes) | (1/2/3 bytes)
SET/GET Space SYS Space ROUTE- X/ XX/ XXX =
MODE
X is the mode This is ASCII

value

carriage return
0xod

A. GET (Recall) the route mode saved before:
For example, GET (Recall) the route mode 1

Send: GET SYS ROUTE-MODE 1+

B. SET (Save) current route to a mode:
For example: SET (Save) current route to mode 1
Send: SET SYS ROUTE-MODE 1+

www.seada.co.uk
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6.4. Set Video Wall:
Operation | Spacer Target Spacer | Command Command | Command
type type arameters tail
P (1 byte) (N bytes) (Lbyte) | P P
(3 byte) (10 bytes) (N bytes) (1 byte)
SET Space OUTx/OUTxx/OUTxxx | Space TVWALL Line: !
Column: ..
x is the output port p: This is
number Q ASCII
C carriage
OUT1/0UT01/0UTO Margin- 0x0d
Right: X
01
Margin-Top:
Margin-
Bottom:
Input:

A. SET Video Wall mode of one output port
Picture-1 Screen 6/7/10/11, and the source input is input 1

For example:

Send: SET OUT6TVWALL2211020020 1+ Receive: OUT6 TVWALL22110200201

Send: SET OUT7TVWALL2212200020 1+ Receive: OUT7 TVWALL22122000201

Send: SET OUT10 TVWALL22210202001+ Receive: OUT10 TVWALL22210202001

Send: SET OUT11 TVWALL22222002001+ Receive: OUT11 TVWALL22222002001
Sending these four commands will create a 2x2 splice

B. How to Exit Video Wall mode:

e.g. Exit Video Wall combination of output port 6,7,10,11
Send: SET OUT6TVWALL11110200201+ Receive: OUT6 TVWALL11110200201
Send: SET OUT7TVWALL11110200201+ Receive: OUT7 TVWALL11110200201
Send: SET OUT10TVWALL11110200201+ Receive: OUT10 TVWALL11110200201

Send: SET OUT11TVWALL11110200201+ Receive: OUT11 TVWALL11110200201

www.seada.co.uk
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6.5. Video Wall Mode Save/Recall:
Operation Spacer Target Spacer | Command Command Command tail

type type arameters
P (Lbyte) | (Nbytes) | (Lbyte) | " P (1 byte)

(3 byte) (10 bytes) | (1/2/3 bytes)

SET/GET Space SYS Space TVWALL- | x/xx/xxx «
MODE
x is the mode | This is ASCII
value carriage return
0x0d

GET (Recall) the route mode saved before:

For example, GET (Recall) the route mode 1
Send: GET SYS TVWALL-MODE 1+

SET (Save) current route to a mode:

For example, SET (Save) current route to mode 1
Send: SET SYS TVWALL-MODE 1 «

Receive: SYS TVWALL-MODE 1

Receive: SYS TVWALL-MODE 1

6.6. Source Power On/Off
Operation | Spacer Target Spacer Command Command | Command
type type arameters tail
(;pbyte) (Lbyte) | (Nbytes) | (1byte) P P
(10 bytes) (N bytes) (1 byte)
SET Space INX/INxx/INxxx | Space POWER ON/OFF «
This is
ASCII
carriage
return
0x0d

For example:

Send: SET IN1 POWER ON+* Receive: IN1 POWER ON

6.7. Sink Power on/Off
Operation | Spacer Target Spacer Command | Command | Command tail
type type arameters
3 zste) (1 byte) (N bytes) (1 byte) vp P (1 byte)
(10 bytes) (N bytes)
SET Space OUTx/OUTxx | Space POWER ON/OFF «

/OUTxx This is ASCII
carriage
return Ox0d

For example:

Send: SET OUT1 POWER ON+* Receive: OUT1 POWER ON
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7. Troubleshooting

7.1. No Connection

7.1.1.Ensure the G44 HDMI is powered up

7.1.2.Ensure the PC and G44 HDMI at the same IP group

7.1.3.Ensure the IP address is correct for G44 HDMI

7.1.4.1P address of each device will be shown on screen when no video input is applied.
7.2. No Output

7.2.1.Ensure the video source is on

7.2.2.Ensure the video source device sends the signal out (G44 HDMI INPUT statue LED light
will be on if input video signal presents)

7.3. Black screen
7.3.1.Ensure the G44 HDMI and screens are powered up
7.3.2.Ensure the connection to screens are OK
7.3.3.Ensure the screens on correct channel (DVI or HDMI)

7.3.4.Ensure that the inputs are assigned correctly (i.e. Input 1 on Output 1, Input 2 on
Output 2 etc.
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